For U.S.A.

TO THE USER

This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reason-
able protection against harmful interference
in a residential installation. This equipment
generates, uses, and can radiate radio fre-
quency energy and, if not installed and used
in accordance with the instruction manual,
may cause harmful interference to radio com-
munications.

However, there is no guarantee that interfer-
ence will not occur in a particular installation.
If this equipment does cause harmful interfer-
ence to radio or television reception, which
can be determined by turning the equipment
off and on, the user is encouraged to try to
correct the interference by one or more of the
following measures.

a) Reorient or relocate the receiving anten-
na.

b) Increase the separation between the
equipment and receiver.

c) Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

d) Consult the dealer or an experienced
radio/TV technician for help.

CAUTION

Changes or modifications to this equip-
ment not expressly approved by TEAC
CORPORATION for compliance could void
the user’s authority to operate this equip-
ment.

Declaration of Conformity
Model Number: US-144
Trade Name: TASCAM
Responsible party: TEAC AMERICA, INC.
Montebello, California, U.S.A.
Telephone number: 1-213-726-0303

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions:
(1) This device may not cause harmful interfer-
ence, and
(2) This device must accept any interference
received, including interference that cause undesired oper-

This appliance has a serial number
located on the rear panel. Please
record the model number and serial
number and retain them for your
records.
Model number
Serial number
IMPORTANT SAFETY INSTRUCTIONS

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with dry cloth.
7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9. Only use attachments/accessories specified by the manufacturer.
10. Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.

- Do not expose this apparatus to drips or splashes.
- Do not place any objects filled with liquids, such as vases, on the apparatus.
- Do not install this apparatus in a confined space such as a book case or similar unit.

* Microsoft, Windows, and Windows XP are registered trademarks in the United States and other countries of Microsoft Corporation, USA.
* Pentium is a registered trademark of Intel Corporation, USA.
* MIDI is a registered trademark of the Association of Musical Electronics Industries.
* Other company names and product names in this document are the trademarks or registered trademarks of their respective owners.
Contents

1 Introduction
   Overview ........................................... 5
   Features ........................................... 5
   What is in the package .......................... 5
   Conventions used in this manual ............... 6

2 Parts of the US-144
   Top panel ......................................... 7
   Rear panel ...................................... 8
   Front panel ...................................... 9

3 Installation
   System requirements ............................. 10
      Windows XP .................................. 10
      Mac OS X ..................................... 10
   Installing the drivers .......................... 11
      Installing the drivers
         for Windows XP ............................ 11
      Installing the drivers
         for Mac OS X .............................. 12
   Installing Cubase LE ........................... 12
   Settings on your computer ..................... 12

4 Control panel settings
   Overview .......................................... 13
   Driver settings ................................... 13
      Audio Performance ........................... 13
      Sample Clock Source ........................ 13
      Digital Output Format ....................... 14

5 Connections
   USB connections .................................. 15
   Audio connections .............................. 15
   MIDI connections ............................... 17

6 Recording with Cubase LE
   Input setting .................................... 18
   Recording ....................................... 19
   Mixdown ........................................ 20

7 Troubleshooting ................................. 21

8 MIDI Implementation
   Chart .............................................. 23

9 Specifications and
   performance
   Audio specifications ............................ 24
   Audio performance ............................. 25
   Other characteristics .......................... 25
   Physical characteristics ...................... 26
   Dimensions ..................................... 26
Please read this owner’s manual carefully before you begin using the US-144, and use the product correctly as directed in order to ensure long and trouble-free enjoyment of all its functionality.
After you have read this manual, keep it nearby for reference when required.
We can accept no responsibility for any loss of the data you record using this product onto other MIDI equipment in your system or onto storage devices such as hard disk.

1 – Introduction

Overview

The US-144 is a USB-based audio interface designed for use with Digital Audio Workstation (DAW) software. It provides a four-input, four-output 24-bit 96 kHz audio interface and a 16-channel MIDI interface.

Because the US-144 is USB-based, it is the ideal companion to any desktop- or laptop-based digital recording setup. And since the US-144 operates using only USB power, you can use it with a laptop computer to create a very compact and portable digital audio workstation system.
The US-144 is also an ideal way to capture analog sources such as records or cassette tapes into your computer and preserve them as audio CDs.

Features

- 24-bit / 96 kHz audio interface.
- Analog input signals (L, R) and digital input signals (L, R) can be input at the same time and recorded simultaneously into your computer via USB.
- Two XLR mic/line inputs (balanced) and two 1/4” phone mic/line inputs (balanced/unbalanced) are provided. One of the 1/4” phone inputs can be switched to allow direct input of an electric guitar or electric bass (R channel only).
- Stereo digital input jack and stereo digital output jack.
- Unbalanced stereo line output (RCA connector) and headphone output.
- MIDI IN/OUT.
- Direct Monitor function allows zero-latency monitoring of the input.
- Power is supplied by the USB connector.

A note about computer operation

If you are unsure about how to perform basic computer operations appearing in this manual, please refer to the owner’s manual that came with your computer.

What is in the package

The US-144 package contains the following items.
- US-144 main unit
- USB cable
- Owner’s manual (this document)
- CD-ROM (containing drivers and manuals)
- CD-ROM (Gigastudio 3 LE) [Windows only]
- CD-ROM (Cubase LE)
1 – Introduction

Conventions used in this manual

The following conventions are used in this manual:

Front panel keys, knobs, and indicators, and rear panel connectors are designated in all-capital letters.
Example: **LINE IN** jacks

This typeface is used to designate messages displayed by the software.
Example: Control Surface Protocol

*This typeface* is used to designate software menu functions and on-screen controllers.
Example: **ASIO Device**
Top panel

1. **LINE OUT level knob** Controls the output level of the LINE OUT jacks.
2. **PHONES LEVEL knob** Controls the output level of the PHONES jack.
3. **MIDI IN indicator** Lights when MIDI data is being received at the MIDI IN connector.
4. **MIDI OUT indicator** Lights when MIDI data is being transmitted from the MIDI OUT connector.
5. **MON MIX balance knob** Controls the balance of the signal sources being output from the LINE OUT jacks and the PHONES jack. When this knob is turned to the far left, the signal being input to the US-144 (from the XLR jacks, or 1/4" phone jacks) will be output. When this knob is turned to the far right, the output signal received from the computer via USB will be output.
6. **MONO switch** Turn this switch ON if you want to monitor in monaural. This switch affects only the analog input signal.
7. **INPUT knobs (L, R)** Adjust the level of the audio signal being input to the MIC IN jacks and LINE IN jacks.
8 **SIG/OL indicators** Light when signals are being input to the input channels (L, R). They will light green to indicate a signal is present, and will light red immediately before distortion occurs. These indicators apply only to the analog inputs.

**NOTE**

These indicators will light green when the input signal level is in the range of -30 dBFS to -2 dBFS. The indicators will light red when the input signal level exceeds -2 dBFS.

9 **MIC/LINE-GUITAR select switch** Set this switch as appropriate for the input source you have connected to the LINE IN jack R channel. Use the GUITAR position if you have directly connected an electric guitar or electric bass. Use the MIC/LINE position if you have connected an electronic musical instrument, audio device, or mic.

10 **PHANTOM switch** Turns on the +48V phantom power supplied to the MIC IN jacks.

**WARNING**

Microphones should not be connected to or disconnected from the US-144 with phantom power switched on. Unbalanced dynamic microphones should never be connected to phantom-powered connectors.

**NOTE**

Turn this switch on only if you are using condenser microphones that require phantom power. Please note that if you are operating the unit with a battery-powered laptop computer, the battery life of the computer will be reduced if the PHANTOM switch is on.

---

### Rear panel

11 **USB connector** Use a USB cable to connect this to the host computer’s USB 2.0 port.

**NOTE**

If the US-144 is operating with a USB 1.1 (Full Speed) connection, only two channels of recording/playback will be available.

12 **MIDI OUT connector** Transmits MIDI messages.

13 **MIDI IN connector** Receives MIDI messages.
2 – Parts of the US-144

**14** LINE OUT L/R jacks (RCA connector, unbalanced) These are analog stereo output jacks.

**15** DIGITAL IN jack This is an RCA connector that inputs a stereo S/PDIF digital signal.

**16** DIGITAL OUT jack This is an RCA connector that outputs a stereo S/PDIF digital signal.

**NOTE**
The US-144's DIGITAL IN/OUT jacks allow simultaneous input and output at 24-bit/96 kHz.

**Front panel**

**17** MIC IN (L, R) jacks (XLR balanced) These are analog mic input jacks. The wiring is as follows: pin 1 = ground, pin 2 = hot, pin 3 = cold.

**18** LINE IN (L, R) jacks (TRS 1/4" phone jacks) These are balanced line input jacks. The R channel also accommodates guitar input. If the top panel MIC/LINE-GUITAR select switch is in the GUITAR position, the R jack operates as an unbalanced input jack for guitar.

If the MIC/LINE-GUITAR select switch is in the MIC/LINE position, the R jack operates as a balanced input jack. (Sleeve = ground, tip = hot, ring = cold)

**19** PHONES jack (stereo 1/4" phone) This is a headphone output jack.
3 – Installation

System requirements

Windows XP

Supported operating system: Windows XP SP2

Recommended system: Pentium or Athlon 1 GHz or faster (or equivalent processor), 512 MB or more memory, USB 2.0 port

These requirements are for when using Cubase LE. If you are using other application software, you will need to consult the operating requirements for the software you are using.

NOTE
The number of usable audio tracks will depend on the speed of your hard disk. The faster your hard disk, the better your results will be.

If the US-144 is operating with a USB 1.1 (Full Speed) connection, only two channels of recording/playback will be available.

We recommend that you have at least 256 MB of memory, but when using digital audio application software, the more memory you have the happier you will be.

Although this product has been checked for use with typical computers that meet the above operating requirements, we cannot guarantee that it will operate with all computers that meet these requirements. Please be aware that even under the same conditions, processing capability may vary depending on differences of the design and system.

Mac OS X

• Macintosh computer with a USB 2.0 connector
• Mac OS X 10.3.9 & higher on PowerPC Mac systems

For Macintosh as well, the more memory you have and the faster your hard disk, the happier you will be when using digital audio application software.
Installing the drivers

In order to use the US-144, you must install the appropriate drivers into your computer. As described below, this is an easy process using the CD-ROM included with the US-144.

Drivers are updated from time to time. You can download the most recent version of the drivers from the TASCAM website <http://www.tascam.com/>.

Do not connect the US-144 to your computer before you have installed the drivers.

**CAUTION**

Handle the enclosed CD-ROM with care. If the disc becomes scratched or dirty, your computer may be unable to read it and the software cannot be installed. If the disc becomes unreadable, a fee will be charged for its replacement.

**WARNING**

Never attempt to play the enclosed CD-ROM in a conventional audio CD player, as the resulting noise may damage your speakers or your hearing.

Installing the drivers for Windows XP

The US-144’s drivers are provided on the CD-ROM as an executable installer entitled US-122L & US-144 driver x_yy.exe. (x_yy is the version number.)

**Installation procedure**

1. Make sure that the US-144 is not connected to your computer.
2. Double-click the executable installation file US-122L & US-144 driver x_yy.exe. The installer will start up.
3. Select the desired language from the menu and click the OK button. A dialog box will appear.
4. Click the Install the Driver button. The drivers will be installed.

**NOTE**

During driver installation, a warning that this software has not passed Windows Logo testing will appear. This warning appears when you attempt to install a driver that has not passed Windows Logo testing; however, please be assured that TASCAM has verified that this driver for Windows XP does work correctly.

If this message appears, click Continue to proceed with the installation.

If a message asks you to restart your computer, restart your computer. After restarting, connect the US-144 to your computer. The Windows Plug and Play system will detect the new USB hardware, and the Add New Hardware wizard will start up. The wizard will automatically find the necessary files. (This will take about 30 to 60 seconds.)

The drivers are now installed, and the US-144 is ready to operate.
3 – Installation

Installing the drivers for Mac OS X

The US-144’s drivers are provided on the CD-ROM as a package file entitled US-122L & US-144 driver x_yy.mpkg. (x_yy is the version number.) Simply double-click on this package file’s icon to launch it and follow the directions that appear on your screen.

Installing Cubase LE

1 Insert the Cubase LE CD-ROM into your computer. The opening screen will appear.

2 Click the Install Cubase LE button.

3 Enter the serial number of Cubase LE. The Cubase LE serial number is affixed to the soft case of the Cubase LE disc.

4 When you have finished entering the information, click the OK button.

5 Follow the instructions shown on the screen with the installation. When the installation is completed, a dialog box indicating that installation was successful will appear, and then you will return to the opening screen.

6 Close the opening screen.

Settings on your computer

Here are a few basic points to help you set up your computer for best performance with audio applications.

- Do not run other applications. You will probably use your computer for applications other than audio, but we recommend that you avoid running other applications at the same time you are running audio programs. Processing digital audio places a considerable load on your computer. This means that if you are running other applications (especially graphics or Internet tools) at the same time as your audio application, the processing may not happen fast enough.

- Certain devices such as network cards or WinModems can cause conflicts with USB processing. If you experience such a conflict, you can use the Device Manager to temporarily disable the offending device.

- If your computer has an IDE hard disk, enabling Direct Memory Addressing (DMA) will improve performance. In Windows XP, this is enabled by default.
Overview

The Control Panel lets you make various settings for the US-144’s functionality. The Control Panel is divided into the following two sections.

Status section

This shows the current status of the driver and the connected hardware. You cannot edit the settings from this section.

Setting section

Here you can edit the various settings of the driver.

Driver settings

Audio Performance

The US-144 driver temporarily stores input and output audio samples in buffers. The Audio Performance setting lets you adjust the buffer size. The Lowest Latency setting is the minimum buffer size, and the Highest Latency setting is the maximum buffer size.

A smaller buffer size will reduce the delay when monitoring the input signal, but will require your computer to perform the processing faster. If the processing does not occur in time (e.g., if other system operations are occurring), you may hear clicks, pops, or dropouts in the audio signal.

A larger buffer size provides more safety against such problems caused by other system activities, but will produce greater delay when monitoring the audio signal. The US-144 lets you select the buffer size that works best for your system.

Sample Clock Source

You can set the clock source to Automatic or Internal.

Automatic (default): If a signal is being input to the DIGITAL IN jack, its clock will be used. If no signal is being input to the DIGITAL IN jack, the US-144’s internal clock will be used.

Internal: The US-144’s internal clock will always be used.
Digital Output Format
This lets you choose either AES/EBU or S/PDIF as the digital output format.
Many professional devices use an XLR connector for AES/EBU. Special adapters may be purchased to convert between a digital audio RCA connector and digital audio XLR connector.

USB 1.1 Mode Input Selection
This item is shown only if the US-144 is connected to a USB 1.1 port on the host computer or to a USB 1.1 hub. In this case, the US-144 functions as a 2-in / 2-out audio device, rather than the usual 4-in / 4-out. You can choose either Analog or Digital as the input source.
USB connections

Using the included cable, connect the US-144 to your computer as shown in the illustration.

**NOTE**

Some USB devices access the USB bus frequently. To avoid dropouts and clicks in the audio signal, we strongly recommend that you do not connect other USB devices to the USB bus used by the US-144. USB keyboards and mice are exceptions to this, and will probably not cause problems.

Audio connections

Connect the output signal of your mic, guitar, keyboard, or other audio device to the US-144, where it will be converted into digital audio and sent via USB to your computer. Connect the output of the US-144 to your speakers (via an amp) or headphones, so you will be able to monitor the audio signals coming into the US-144 or being produced by your computer.

**NOTE**

The US-144 has two input channels (L, R), with a MIC IN jack (XLR) and LINE IN jack (1/4" phone jack) provided for each channel. Do not connect signals to both of these analog input jacks at the same time. If both are connected, the signal will not be correctly input to the US-144.

Mic

Connect your mics to the **MIC IN (L, R)** jacks (XLR). If you are using a condenser mic that requires phantom power, turn on the phantom power.

If you’re using a condenser mic
5 – Connections

Guitar
Connect your guitar to the R-channel LINE IN jack (1/4” phone jack) and set the MIC/LINE-GUITAR switch to GUITAR.

Keyboard / drum machine / sound module / cassette deck / MD / CD etc. (analog connection)
Connect the analog audio output of these devices to the LINE IN (L, R) jacks (1/4” phone jack). If you use the R-channel, set the MIC/LINE-GUITAR switch to LINE.

Sound module / MD / CD etc. (digital connection)
Connect the digital audio output of these devices to the DIGITAL IN jack.

NOTE
The US-144’s digital input jack is an RCA connector.

Analog record player
The output of an analog record player cannot be connected directly to the US-144. You must connect a phono amp between your analog record player and the US-144. (Alternatively, you can connect it via an audio amp that has PHONO inputs.)
5 – Connections

Speakers/headphones

Headphones
Powered speakers, or amp and speakers

MIDI connections

Connect your sound module, keyboard/synthesizer, drum machine, or other MIDI device to the US-144 as shown below.

You can use the MIDI IN/MIDI OUT connectors to transmit and receive MTC (MIDI Time Code). This allows the MTC-compatible DAW (Digital Audio Workstation) computer application to synchronize with your MIDI equipment.
This chapter explains the basics you will need to understand when using the US-144 with Cubase LE. This discussion is not intended to replace the user manual of your software. If you have questions specific to Cubase LE, please refer to the Cubase LE user manual.

### Input setting

1. **Start up Cubase LE. From the Devices menu, choose Device Setup.** The Device Setup window will appear.

2. From the device list in the left side of the Device Setup window, choose VST Multitrack.

3. In the right side of the window, click the Setup tab, specify the ASIO Driver for the interface that uses an ASIO driver, and click the Apply button. If you have connected the digital input, set the Clock Source to external.

4. **From the Devices menu, choose VST Inputs to access the VST Inputs window.** Verify that the Port field shows the input name of the audio interface you are using, and that the Active indicator is lit.
5 From the File menu, choose New Project. A window will appear, allowing you to choose a template for your new project. Choose the desired template and press the OK button. Specify the location in which to save your project, and the new project will be created.

Now you are ready to begin recording.

**Recording**

1 As the input for the track you want to record, choose an input channel of the audio interface you are using. Then press the REC FUNCTION button to enable recording for that track.

2 In the transport, press the REC button to begin recording.

3 When you are finished recording, press the STOP button, and then press the REC button to disable recording. Rewind if necessary.

4 Repeat steps 1, 2, and 3 to overdub additional tracks.
6 – Recording with Cubase LE

Mixdown

1 Move the left and right locators to specify the region that you want to mix down.

2 From the File menu, choose Export -> Audio Mixdown.

3 In the Export Audio Mixdown dialog box, make the desired settings and then press the Save button.
This chapter lists frequently asked questions related to recording with Cubase LE, with answers to these questions.

Q. I have finished making input settings, but the meter of the audio track is not moving.
A. Make sure that the monitor button of the track is enabled.

Q. I would like to record two channels simultaneously for a stereo recording.
A. Before you record, press the stereo/mono select button of the track so that the yellow indicator is lit. In this case, the track input is shown as In 1 + In 2 or a similar indication.

Q. I am trying to use the EQ, but it does not seem to do anything.
A. Check the VST channel settings etc. to make sure that EQ bypass is not enabled.

Q. I mixed-down a song that was three minutes long, but the result was only ten seconds long.
A. Make sure that the left and right locator region is set to the entire range that you want to mix down.

Q. I cannot set the locator region to more than ten minutes.
A. The default setting is ten minutes. From the Project menu, choose Project Setup and adjust the length of the project.
Q. I performed a mixdown, but the automation and effects were not reflected in the mixdown.
A. In the Export Audio Mixdown dialog box, make sure that automation and effects are enabled.

Q. I made a CD using the WAV file I mixed-down, but the speed is obviously different.
A. Could your project be set to 48 kHz? If your ultimate objective is to create a CD, we recommend that you work in 44.1 kHz from the beginning.
To specify the sample rate, pull down the Project menu, choose Project Settings, and set the sample rate to 44,100 Hz.

Q. Using the ReWire protocol, can I record the incoming audio on a track?
A. In Cubase LE, ReWire tracks do not have recording capability. You will have to export the audio data, and then import it into an audio track.

Q. I have connected an audio source to the US-144, but cannot hear anything.
A. Make sure that the input level is raised appropriately. If the input is analog, the green indicator will light when a signal is being input. Make sure that the monitor (or headphone) level is raised, and that the connections are correct.

Q. The sound is distorted.
A. Make sure that the signal is not overloading. The ideal level is when the red indicator lights occasionally.
<table>
<thead>
<tr>
<th>Function</th>
<th>Transmitted</th>
<th>Received</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Channel</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Mode</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Note Number</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Velocity</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>After Touch</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Pitch Bender</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Control Change</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Program Change</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>System Exclusive</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>System Common</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>System Real Time</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
<tr>
<td>Other</td>
<td>X</td>
<td>X</td>
<td>Through</td>
</tr>
</tbody>
</table>

**Notes**

**Mode 1:** Omni on, Poly  
**Mode 2:** Omni on, Mono  
**Mode 3:** Omni off, Poly  
**Mode 4:** Omni off, Mono  

**O:** Yes  
**X:** No
### 9 – Specifications and performance

#### Audio specifications

<table>
<thead>
<tr>
<th>Nominal input levels</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MIC IN L and R</strong> (XLR balanced)</td>
<td>–58 dBu (TRIM=max) to –14 dBu (TRIM=min)</td>
</tr>
<tr>
<td><strong>MIC/LINE-GUITAR L and R in</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MIC/LINE</strong> position (1/4” jack, unbalanced)</td>
<td>–40 dBu (TRIM=max) to +4 dBu (TRIM=min)</td>
</tr>
<tr>
<td><strong>MIC/LINE-GUITAR R</strong> in <strong>GUITAR</strong></td>
<td></td>
</tr>
<tr>
<td><strong>position</strong> (1/4” jack, unbalanced)</td>
<td>–51 dBu (TRIM=max) to –7 dBu (TRIM=min)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum input levels</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MIC L and R</strong> (XLR balanced)</td>
<td>+2 dBu (TRIM=min)</td>
</tr>
<tr>
<td><strong>MIC/LINE-GUITAR L and R in</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MIC/LINE</strong> position (1/4” jack, unbalanced)</td>
<td>+20 dBu (TRIM=min)</td>
</tr>
<tr>
<td><strong>MIC/LINE-GUITAR R</strong> in <strong>GUITAR</strong></td>
<td></td>
</tr>
<tr>
<td><strong>position</strong> (1/4” jack, unbalanced)</td>
<td>+9 dBu (TRIM=min)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input impedance</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MIC IN L and R</strong> (XLR balanced)</td>
<td>2.4 kΩ</td>
</tr>
<tr>
<td><strong>MIC/LINE-GUITAR L and R in</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MIC/LINE</strong> position (1/4” jack, unbalanced)</td>
<td>10 kΩ</td>
</tr>
<tr>
<td><strong>MIC/LINE-GUITAR R</strong> in <strong>GUITAR</strong></td>
<td></td>
</tr>
<tr>
<td><strong>position</strong> (1/4” jack, unbalanced)</td>
<td>1 MΩ</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Nominal output level</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LINE OUT</strong> (RCA unbalanced)</td>
<td>–10 dBV</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum output level</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LINE OUT</strong> (RCA unbalanced)</td>
<td>+6 dBV</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output impedance</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LINE OUT</strong> (RCA unbalanced)</td>
<td>100 Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum output power</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PHONES</strong> (1/4” stereo jack)</td>
<td>14 mW + 14 mW (32 Ω)</td>
</tr>
</tbody>
</table>
9 – Specifications and performance

Audio performance

<table>
<thead>
<tr>
<th>Signal-to-noise ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LINE IN</strong> (through ADC and DAC) to <strong>LINE OUT</strong></td>
</tr>
<tr>
<td><strong>LINE IN</strong> (through direct monitor) to <strong>LINE OUT</strong></td>
</tr>
</tbody>
</table>

Total harmonic distortion (THD+N, 22 Hz to 22 kHz)

| **LINE IN** (through ADC and DAC) to **LINE OUT** | < 0.006% (1 kHz sine +20 dBu input, TRIM=min.) |
| **LINE IN** (through direct monitor) to **LINE OUT** | < 0.0.04% (1 kHz sine +20 dBu input, TRIM=min.) |

Other characteristics

Digital audio

| A/D Conversion (AK5381) | 24-bit/96 kHz, 27.6 samples delay |
| D/A Conversion (AK4384) | 24-bit/96 kHz, 19.3 samples delay |

MIDI

| MIDI IN and MIDI OUT ports (DIN 5-pin) | Conform to MIDI standards |

USB

| USB port (down stream connector) | USB 2.0 Format |

Host computer compatibility

| Operating system | Windows | Windows XP |
| Macintosh | Mac OS 10.3.9 or later |
| Communication | USB 2.0 |
| Audio/MIDI interface protocols | Windows | ASIO, ASIO2, GSIF2, WDM |
| Macintosh | CoreAudio, CoreMIDI (OS X) |
| Bundled software | Cubase LE (for Windows or Macintosh), Gigastudio 3 LE (Windows only) |
Physical characteristics

Dimensions

<table>
<thead>
<tr>
<th>External dimensions (w x h x d)</th>
<th>147 x 192 x 48 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>1 Kg</td>
</tr>
</tbody>
</table>

Power

Supplied via USB 5V, maximum current 500 mA

Dimensions